


New videos can be added through a pop-up menu, accessible by
right-clicking the mouse inside the Project Window. Select
Project > Add Video(s)... from the pop-up menu [ Figure 2],

and load the demo_hotwheels.avi video file.
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Figure 2

The Project Window can contain and manage multiple video files. As an example, repeat

the previous step to add the demo_heartvalve.avi and demo_switchblade.avi videos.

Step 2 — Navigating the ProAnalyst Interface

The ProAnalyst interface consists of 4 primary windows. Currently the Project Window,

Workspace View, and Active Timeline are visible. The Measurement Window can be

launched by double-clicking the mouse on the demo_hotwheels.avi video thumbnail. Your

workspace should resemble Figure 3.
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Figure 3

A. The Project Window manages multiple video and data files, and provides thumbnail

views of project video clips.



B. The Measurement Window is used for video processing/analysis and graphing

actions. The majority of ProAnalyst work takes place in this window.

C. The Workspace View displays active projects, as well as their associated video, data,
and configuration files in either tree or graphical format.

D. The Active Timeline provides synchronization and visualization of multiple video
tracks, data, and graphs. Data patterns and subtle events can be easily viewed from
this window.

This tutorial will focus primarily on the Measurement Window. The Workspace View and
Active Timeline will not be used. These windows may be closed by clicking the ‘X’ button

in the top right or left hand corner.

The Measurement Window in Depth

The majority of video and data analysis takes place in the Measurement Window. Across
the top of the Measurement Window is the Main Toolbar [ Figure 4 ], which controls the
viewing options and appearance of the video controls, video image, and displayed data.
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Figure 4

The Video View tabs [ Figure 5 ], located along the left side of the Measurement Window,

provide different viewing options for the video image.

% Raw displays the original, unaltered video image directly from the source file.
o
T
% Processed shows the results of any Image Processing or Image Filtering
a operations on the video image.
o
=
=
E Thumbnail displays a thumbnail summary of the entire video sequence.
=
Figure 5

Along the right side of the Measurement Window is a toolbar that contains a column of

icons [ Figure 6 ]. Each icon in the toolbar opens a control panel representing an operation



Y

S B m

. ...*. 1::" I_.n;' g

M

Figure 6

that can be performed on a video. Note that the specific icons that appear will depend on

which version of ProAnalyst you are using.
Image Processing controls color balance, brightness, contrast, etc.
Image Filtering contains powerful image manipulation tools.

Image Calibration allows calibration to real-world coordinates.

Display Layers controls what is displayed in the video image.

Notes allows recording/editing of notes relating to the current video analysis.
Annotations allow the user to add graphical annotations to the video image.
Line (1D) Tracking follows intensity changes along a one-dimensional line.
Feature (2D) Tracking tracks distinct features across all video frames.

Stabilization removes unwanted bounce or jitter prior to video analysis

Contour Tracking tracks the contour of an object frame-by-frame.

Particle Tracking automatically detects and characterizes particle motion.

Cellular Tracking tracks the flow of biological cells through veins and arteries.

Configure Graph customizes graph output, including analysis and data.

A set of video play controls [ Figure 7 ] are located at the bottom of the Measurement
Window.
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The Play Controls allow for forward or reverse video playback or frame-by-frame stepping.
The video length, current frame, and current time are displayed, as well as frame jump,
frame skip, and continuous playback options. Refer to the ProAnalyst User Guide for more

details.



Step 3 — Importing and Synchronizing External Data with Video

Known as “sensor fusion”, the synchronization of video and sensor data provides a much
richer understanding of events than either technology alone. ProAnalyst allows users to
import data streams from external sensors and gauges, and then synchronize the data
streams with video(s). If video and data were recorded together in one of ProAnalyst’s

supported formats, the data would be automatically read and synchronized.

To import external data contained in an ASCII text file, open the Import Data dialog box [
Figure 8 ] by selecting File 2 Import Data & From Text. Click the Browse button at the

top of the dialog, and select the demo_hotwheels_data.txt file.

Import Data
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Figure 8

In the Data Information frame [ Figure 9 ], check the boxes marked First Field Contains:

and Second Field Contains:. Leave the other dialog properties at their default values.

Data Information

* Sample Mumber ¢ Time®
" Sample Murber ™ Time*

The data map have been sampled at a faster rate than the video.
Ta align video and data, indicate the samples per frame and the zero-th sample.

Samples per Frame |1 Zerorth Sample |1
Figure 9




Auto-tracking is the ability of ProAnalyst to automatically find and track user defined
features, and then determine frame-by-frame motion characteristics with respect to the
image plane. This automatic tracking capability will be demonstrated by tracking two
features on the car is it moves through the video — in this case, the number “3” painted on

the car door, and the accelerometer mounted on the windshield.

To track the “3”, begin by clicking the 2D icon to open the Feature Tracking control panel,
and then click the Enable button at the top of the control panel to activate the panel. Notice

that one feature is automatically added to the Features list.

ProAnalyst will begin auto-tracking on the currently displayed video frame. Click the 22

button to move the video to frame 0, if it is not there already.

The next step is the definition of a template representing the object you wish to track. Click
the Define Region button, located at the bottom of the Features frame, and then click and
drag the mouse to draw a box around the number “3” [ Figure 18 ]. After the box is drawn, it

can be repositioned by clicking and dragging it to a new location on the image.

S

Figure 18

With the tracking template defined, click the Set Region button. Features
The box will change color and display a small number 1, indicating Add | Hemove| Clear |
that it is the first feature in the feature list. In the feature list, you F1| cnolabel | 4 [ H w

will note that the new feature is titled “<no label>" [ Figure 19 ]. A Figure 19



feature settings window can be opened by clicking the @, icon associated with a feature.

The Track Settings window provides access to all the parameters involved in auto-
tracking. Type some text (for example, the word “Three”) in the “Feature Label” text field to
define a label for the feature. The other parameters in the window may remain at their
default values. Click the Apply button, followed by the Close button at the bottom of the
dialog. The new title will now be displayed above the bounding box surrounding the selected

feature.

New features can be added to the window by clicking the Add button. Add a new feature to
the list, and then define and set a template for the accelerometer mounted on the windshield
of the car. Open the Track Settings window for this feature, and type a label
(“Accelerometer”, for example) in the “Feature Label” field. Your image should now

resemble Figure 20.
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B Figuf'é 20 .
When you have defined and set both template regions, click the Track Forward button. The

video will advance frame-by-frame as ProAnalyst tracks the selected features and marks

their positions on the screen [ Figure 21 ].



By default, ProAnalyst will display every tracked point on the

screen simultaneously. Depending on what frame you are on in UeIne mEgUn | @ negun
the video, seeing all of the tracking marks can be visually Feature Lines
. « » . « . " Configure
confusing. Below the “Features” frame is the “Show Points” pull- ‘W
Tracking

down list [ Figure 22 ]. Click on the pull-down list and select the

— =
“Show Past” option. This option will only display the tracking Figure 22
points associated with the current frame, as well as any previous

frames.

Viewing Real-time Measurements

The Show Measurements window provides real-time motion analysis results, such as
current position and velocity, for each feature being tracked. It can be opened by clicking

the B button on the Measurement Window toolbar.

Measurement values can be added through a selection window

that is opened by clicking the = icon on the Show

Measurements window. In the selection window, expand the -

Feature 1 [Thres]

“2D" list and click the boxes next to “Feature 1 (Three)” and B Fectae 2laccekzonstl

“Feature 2 (Accelerometer)” [ Figure 23 ]. When you have Figure 23
selected the values you wish to display, click the OK button.
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Step 7 - Graphing Video and Data Analysis Results

ProAnalyst allows immediately plotting of any tracked data, as well as associated sensor

data. You may open the graph pane by clicking the = icon. When the graph is opened,
you will see the data from the accelerometers that was plotted when the external sensor
readings were imported into ProAnalyst [ Figure 25 ]. The accelerometer sensor channels
are plotted in the same colors (red and green) as the tracked points in the video window. To

avoid confusion, the colors used to plot the sensor data will be changed.
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Begin by clicking the M icon to open the Graph Configuration control panel. Double-click
the mouse on the red dot next to “Data — Channel 0” in the Graph Lines frame to open the

Graph Line Appearance window.



Click on the box labeled “Color” to open a color picker [ Figure 26 ]. [l IENE

. . Channel Data - Channel 0 (]
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Figure 26

Repeat the preceding steps to change the plot color of “Data —

Channel 1” (to yellow, for example). The next step will be to plot the

tracking information.

In terms of tracked data, it is possible to plot the X and Y positions of any tracked points, as
well their instantaneous speed, and distance from the origin. For this example, the speed of
both tracked features will be plotted alongside the accelerometer data. Before plotting the
tracked points, confirm that the “Units” drop-down menu located in the Feature Tracking
control panel is set to the calibration units of your choice, otherwise the graph will be
displayed in pixel units by default.

Open the Select Items to Add to Graph window by clicking " e

the Add button in the Graph Lines frame. You will note that the Sl
selection window is of a similar configuration to the image Egii:ﬁ%’iﬁx
filtering window used previously. Expand the 2D list, and check Eﬁiii:iii
the boxes next to “Feature 1 (Three) — Speed” and “Feature 2

(Accelerometer) — Speed” [ Figure 27 ], then click the OK button.

Cancel
Figure 27

Your graph will now display a plot of the speed in inches/sec of your two tracked features,
as well as the imported accelerometer data. However, you will notice that the new graph
lines are plotted in the same colors (blue and yellow) as the sensor data plot lines. Follow
the steps above to change the colors of the feature speed graph lines so that they match

the colors of the tracked points in the video image (red and green) [ Figure 28 ].
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Step 8 — Adding Notes and Annotations to a Video

Video Annotations

Annotations provide the ability to overlay your own labels, measurements, or other objects
directly onto a video sequence. These annotations can be configured to display on every
frame of a movie, or can be limited to a specific frame or frames. Annotations are managed

through a control panel which can be opened by clicking the * icon.

i1

Go to frame 0 of the video, and the click the = | (Draw Length Dimension) icon. Length
dimensions are strait lines drawn between two points within the video. The length of the line
will be displayed in whatever units the video is calibrated to. To draw a length dimension,
click and drag a line along the bottom of the track from the edge of the screen to the lego

wall [ Figure 29 1.



Accelerometer

* Figure29
After the line has been drawn, its length and position can be altered by clicking and
dragging the control points at either end to adjust the positioning of the endpoints. The
length dimension can be moved as a unit as well. Click and drag the Length Dimension to

line it up with the bottom of the track [ Figure 30 ]. Click anywhere in the video frame to
deselect the Length Dimension.

fccelerometer

Advance the video to frame 25. Draw another Length Dimension, this time positioned along
the bottom of the car [ Figure 31 ].
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Video and Data Notes

ProAnalyst allows users to keep a running log of notes, journal entries, personal findings,

and thoughts in an internal application notepad. This information is stored with the project

such that only qualified users are able to edit journal entries. The Notes control panel

[Figure 32 ] may be opened by clicking the El icon.

In the “Global Notes” text frame you may input any descriptive text
that applies to the entire video and data sequence. For example,
input the date, the video name, the experiment number, and a

description of the test.

Set the video to frame 25. Input a comment regarding the impact of
the car to the wall in the “Video Notes” text frame. These notes will
only be visible when the video is on the frame in which they were

input.

Repeat the previous step for as many other video frames you would
like to add notes to. After you have added multiple notes to the

video, move to frame 0.

Show Motes Step

W Video | |-
v Glabal .
Video Motes

Global Notes

Figure 32



Clicking the Step buttons at the top of the control panel will allow you to automatically cycle

through each video note, without having to use the video controls.

Step 9 — Generating a Report

ProAnalyst has the ability to automatically generate a report based on video, data,
analysis, notes, and annotation content. Reports are assembled and output in a structured
format suitable for printing and web distribution. Currently supported formats include Print,
HTML, and PowerPoint. HTML reports can be opened in all Office products, including Word,
Excel, and Front Page, as well as Internet Explorer, Netscape, and other web browsers.
Reports include a cover page that displays the video and data information, an image of the
first video frame, a graph of any plotted video or data information, and any global note

associated with a video [ Figure 33 ].
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To generate a report, select Tools - Generate Report from the main menu bar. This menu
option will open the “Generate Report” dialog box. The dialog box is comprised of four tabs,

each of which handles a different aspect of report generation.

In the Definition tab, select an HTML output format from the “Type” drop-down menu. With
an output format defined, click the Browse button, located next to the “Filename” text field,
to bring up a save box. Input the name you would like your report to be saved under and
press the “Save” button.

Generate Report El

Click on the Setup tab. Select the All Corresponding Data Destinsion Setp | video | Dt |

button, located within the “Include” frame [ Figure 34 ]. This ¥ Pt caver page [canlains clobal note]
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Step 10 — Saving Your Work

The final step in learning ProAnalyst is understanding the way ProAnalyst saves and
manages tracking data, calibration, etc. As a rule, ProAnalyst does not arbitrarily modify
video or data files. Rather, ProAnalyst incorporates a series of individual save files that

correspond to analysis, image processing, and other operations.

Click on the Project Window to make it active. Select File = Save to save your project

file.

Click on the Measurement Window to make it active. Annotations may be saved by
selecting File = Save Annotations, while notes may be saved by selecting File = Save
Notes. Notes and Annotations will automatically be loaded when the saved Project file is

opened.

Synchronized Data may be saved by selecting File->Save Modified Data. This operation

will not overwrite your original data file.

Image Processing, Image Filtering, Image Calibration, Graph Configuration, and Feature

Tracking each have save buttons on their respective control panels.

ProAnalyst writes its operation save files into whichever directory your project file is saved.
By default, save files take the name of the video they are associated with [ Figure 35 ], but

may be renamed at your discretion.
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Figure 35
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